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            Twin Tec --TCFI Gen 7 & M8FI Racing EFI-- 
Tuning Manual 

 

 

CAUTION: CAREFULLY READ INSTRUCTIONS BEFORE PROCEEDING. DESIGNED FOR 

RACING. NOT LEGAL FOR SALE OR USE IN CALIFORNIA OR ON POLLUTION CONTROLLED 

VEHICLES. 

 

OVERVIEW – CONCEPT 

 

Our Racing EFI system has been designed for offroad racing use in the “King of the Baggers” racing 

series. Each Racing ECU has been designed to plug directly into the factory HD harness. 

 

• 17800 - TCFI7 → 2014-2016 Twin Cam Ultra/Touring - Natural Aspiration Engines (Utilizes OE 1 Bar) 

• 17801 - TCFI7 → 2014-2016 Twin Cam Ultra/Touring - Turbo Engines (Utilizes Trask 2.5 Bar Sensor) 

• 17802 - TCFI7 → 2014-2016 Twin Cam Ultra/Touring - Turbo Engines (Includes DTT 3 Bar Sensor) 

• 17803 - TCFI7 → 2016-2017 Twin Cam Softail Models -NA Engines (Utilizes OE 1 Bar) 

• 17804 - TCFI7 → 2016-2017 Twin Cam Softail Models - Turbo Engines (Utilizes Trask 2.5 Bar Sensor) 

• 17805 - TCFI7 → 2016-2017 Twin Cam Softail Models - Turbo Engines (Includes DTT 3 Bar Sensor) 

• 17808 – M8FI → 2017-2020 M8 Ultra/Touring - Natural Aspiration Engines (Utilizes OE 1 Bar) 

• 17809 - M8FI → 2017-2020 M8 Ultra/Touring - Turbo Engines (Utilizes Trask 2.5 Bar Sensor) 

• 17810 - M8FI → 2017-2020 M8 Ultra/Touring - Turbo Engines (Includes DTT 3 Bar Sensor) 

• 17811 - M8FI → 2018-2020 M8 Softail Models - Natural Aspiration Engines (Utilizes OE 1 Bar) 

• 17812 - M8FI → 2018-2020 M8 Softail Models - Turbo Engines (Utilizes Trask 2.5 Bar Sensor) 

• 17813 - M8FI → 2018-2020 M8 Softail Models - Turbo Engines (Includes DTT 3 Bar Sensor) 

• 2021-2023 M8 ECU – Coming Soon 

→ M8FI and TFI7 require the use of version 20.0+ o the PC_LINK.exc tuning and TCFI_LOG.exe 

logging software. V20.0 has numerous updates including storing the options in the tune file and ECU. 

AUTO-TUNE is included in all of our EFI systems. 

To utilize AUTO-TUNE, the wideband O2 sensors must be installed in the exhaust AND closed loop 

must be enabled in the tune.  After the engine is warm and close loop becomes active, AUTO-TUNE 

http://www.daytona-twintec.com/


   

 
Daytona Twin Tec 240 Springview Commerce Dr  BLD 1-J Debary, FL 32713  TCFI7 M8FI Tuning Manual Rev 3.0  
(386) 304-0700   www.daytona-twintec.com  5/2024 

Page 2 

learns fuel trim corrections.  To apply the fuel corrections to the tune, the uploaded from the ECU and 

applied to the tune (corrections adjust the main and front fuel tables). 

IMPORTANT NOTE: You must do some basic tuning before enabling the AUTO-TUNE feature. The 

tune on your motorcycle must be functioning at a basic level before using this feature.  It must start and 

run without popping and blowing black smoke.  Use the Real Time Data view and the build in data-

logging to monitor and adjust the tune. 

 

• Data Logging is automatically enabled – Anytime the engine is running, data is always recorded by 

the ECU in an endless loop, constantly overwriting the oldest data with the new data. Use the TCFI-M8 

Data Logging software to read back the data that is automatically stored in the ECU. 

• Tuning, monitoring and data log playback occurs via the USB Interface and the PC_LINK.exe tuning 

software or the TCFI_LOG.exe data log viewing software. The USB interface is the small black box; it 

connects between the USB port on your PC and the WEGO IIID (see the diagram labeled TCFI7 & M8FI 

EFI SYSTEM DIAGRAM). 

 

Download Software and device Drivers  
   

◼ PC_LINK_TCFI.exe -- PC Software that is used to tune the ECU. This software is also used to    

program the VIN, Odometer and Auto-Calibrate the ETC System. When using the Auto-Tune feature – this 

software is used to read the learning out of the ECU and apply it to the fuel tables. 

◼ TCFI_LOG.exe is the PC Software is used to view/clear codes, view live data as the engine is running 

or read and view data log files out of the ECU. 

◼ Find the latest software at:  daytona-twintec.com/software 

◼ Run the installer: https://jmschip.com/content/DTT/Software/TCFI_Software_Installer.exe 

◼ Run the update: https://jmschip.com/content/DTT/Software/M8FI-TCFI7_SelfInstallUpdate_204-

1991__041024.exe 

 

A video tutorial for assisting with installing and using the software is available on YouTube: 

 

https://youtu.be/QQCByMf6wpk 

 

 

CAUTION: Tuning the TCFI requires competency in PC operation, using Microsoft Windows 

based programs, and basic engine tuning and fuel injection mapping concepts. The TCFI 

installer is assumed to be familiar with the Harley-Davidson fuel injection system and to have 

access to basic test equipment and factory service manuals. 
 

 

 

 

 

http://www.daytona-twintec.com/
https://jmschip.com/content/DTT/Software/TCFI_Software_Installer.exe
https://jmschip.com/content/DTT/Software/M8FI-TCFI7_SelfInstallUpdate_204-1991__041024.exe
https://jmschip.com/content/DTT/Software/M8FI-TCFI7_SelfInstallUpdate_204-1991__041024.exe
https://youtu.be/QQCByMf6wpk
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TUNING GUIDE 
 

 

 
 

 

Important Note: 
 

Before attempting to modify the current tune, we recommend reading entirely the document 

“TCFI7_and-M8_installation_and _quick_setup.pdf”, available for download on JMS-Daytona 

website. You MUST perform the initial setup and checks as outlined in the said document prior to start 

and run/ride the vehicle.   

 

SOFTWARE INSTALL AND FIRST RUN 
 

After successful software install, open the files location; typically they will be in the following location: 

 

Windows (C:) > Program Files (x86)>Daytona TwinTec>TCFI_Software  

 

Locate in folder the TCFI Launcher.exe icon  and place a shortcut on desktop. Double click on 

newly created shortcut.  

http://www.daytona-twintec.com/
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A window will open listing the two programs available to run: 

   

 
 

For tuning click the image to the left – PC LINK. For data logging and some special features, click the 

image on the right – TCFI LOG. 

 

 

THE PC LINK APPLICATION 
parameters, tables, functions and basic tuning procedure 

 

 

EDITING, CREATING and SAVING TUNE FILES  
 

After initial setup, the tuning process may require multiple edits of the engine tables and parameters using 

PC_Link software. Unless you want to start with a blank slate, editing involves downloading the current 

tune from TCFI, performing the required edits, saving table edits to buffer memory, saving the revised 

setup file to disk, and then uploading it to the TCFI. You should always print out any affected tables and 

parameters and save each revised file with a unique filename. Use a filename that incorporates the 

customer’s name and a date code, such as JMS_20240410_a.dat. We suggest that you create a separate 

folder for all tuning files. Keep detailed written notes on the changes you make and the associated 

filenames. Make frequent backup copies onto removable media such as a USB Flash drive.  

Customers with limited PC experience often become confused and have problems with simple Windows 

file management functions including the use of the Windows Explorer. We regret that we cannot provide 

tech support for Windows related issues. We suggest that you spend some time practicing with the 

http://www.daytona-twintec.com/
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PC_Link_TCFI and TCFI _Log software, including the Copy, Paste, and Modify commands on the right 

mouse button popup menu.   

 

ACRONYMS USED IN THIS DOCUMENT 

 
ACR – automatic compression release 

AFR – air fuel ratio 

BCM – body control module 

BLM – block learn multiplier 

BTDC – before TDC 

CL – closed loop 

DTC – diagnostic trouble code 

ECM – electronic control module, also called ECU, PCM 

ET – engine temperature 

ETC – engine coolant temperature 

IAC – idle air control valve 

IAT – intake air temperature 

MAP – manifold absolute pressure 

USB – universal serial bus (mechanism to connect peripheral devices to computer) 

PCM – power control module 

PW – pulse width (injectors) 

PWM – pulse width modulation  

TB – throttle body 

TCFI – TwinCam Fuel Injection 

TDC – top dead center 

TPS – throttle position sensor 

TGS – twist-grip sensor, sometimes called TGA – twist grip actuator 

VSS – vehicle speed sensor 

WOT – wide open throttle 

 

DOWNLOADING and UPLOADING DATA  
 

The USB interface, P/N 102004, is used for communication with the TCFI module. No additional 

hardware is required. The USB interface connects to the four terminal Deutsch data link connector that is 

part of the WEGO harness, not the OE diagnostic port. The USB Interface has a switch that selects the 

operating mode. For communication with the TCFI, you must use the TC88A And All Others switch 

position.   

Turn the ignition key and engine run/stop switches on to provide power to the TCFI unit properly (some 

newer HD models do not have an ignition key, only engine run/stop switch, controlled by the security 

module). Do not start the engine. 

The PC Link TCFI program has auto-connect capability and a COM port scan function to aid in initial 

setup of the communications link. You can use the Port Setup command from the Communications menu 

to display the dialog box shown below and select the correct COM port. If you are not sure what COM 

http://www.daytona-twintec.com/
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port the USB interface has been assigned to, you can click on the Scan button to automatically detect and 

select the correct port. Before you do so, make sure that the USB interface has been connected to your PC 

and the TCFI module. Both the ignition key and engine run/stop switches must be turned on. Once the 

correct COM port has been selected, the program will remember this setting.    

If you enable the Auto Connect check box, the program will try to connect to the TCFI every time the 

program is started. Please note that you must have the correct COM port selected and the USB interface 

connected to your PC and the TCFI module. Both the ignition key and engine run/stop switches must be 

turned on in order for auto-connect to work.  

Figure 6 – Data Port Setup 

 

Download data by using the READ ECU…. READ ECU TUNE (Bike) → to PC command on the 

Program ECU – Port Setup menu. The program will display the module's firmware ID. Save the tune on 

PC before start editing. You can upload (flash) the ECU your modified tune with the command 

PROGRAM ECU…SEND TUNE → TO ECU (Bike).  

 

In the following sections we will show you how to tune your bike for more power and fun. 

  

Before you tune Make sure that: 

• your engine is in good condition (no advanced wear) and has no mechanical or electrical issues 

• the ignition system works well; if not, fix it: replace spark plugs, wires, coils, controller, if 

necessary  

•  the OEM ECU, OBDII diagnostic port are functional and no DTCs are present 

• you have performed the TCFI system installation and initial setup as described in the TCFI7_and-

M8_installation_and _quick_setup.pdf guide, available for download on Daytona-JMS website.  

• you watched the instructional video on YouTube: https://youtu.be/QQCByMf6wpk 

• you have read the current document entirely and gained a basic understanding of how the 

tuning/logging software works 

http://www.daytona-twintec.com/
https://youtu.be/QQCByMf6wpk
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BASIC CONCEPTS 
 

The main tuning window contains the tuning parameters. They consist of scalar values, tables and 

functions. 

 

 

MAIN MENU GROUPS 

File 

You can: Open files, Save files, Edit Config file, Print various items of interest, open recent files. 

Setup New ECU 

First you need to open the tab Configure – Units and Program Options under Setup New ECU header 

and choose the preferred units. Your choice of units and options will be programmed into the ECU and 

the program; this way you don’t need to remember these settings. 

  

The new ECU setup routine is explained in detail in the TCFI7_and-M8_installation_and 

_quick_setup.pdf guide. You need to follow instructions closely, or you will have an engine running 

erratically or not running at all. 

Scalars 

Scalars are single value numbers, switches, injector size, rev limits, etc. When you click on 

Edit…Scalars in the main window, a sub-menu opens and revealing 4 groups: 

http://www.daytona-twintec.com/


   

 
Daytona Twin Tec 240 Springview Commerce Dr  BLD 1-J Debary, FL 32713  TCFI7 M8FI Tuning Manual Rev 3.0  
(386) 304-0700   www.daytona-twintec.com  5/2024 

Page 8 

     Edit Basic Parameters                                                   Edit Advanced parameters 

             

 

        Edit User Functions                                                    Edit ETC Parameters 

           

You need to set the scalars in Basic Parameters only once, when you perform the initial setup and/if 

need to enter injector size, base PW, VSS, etc. Read detailed parameters description and instructions - 

pages 14 - 17 in TCFI7_and-M8_installation_and _quick_setup.pdf guide. Do not make changes to 

ETC Parameters unless you know what are you doing and why – for example you replaced the TB or 

TGA.  

 

Note: under Setup New ECU menu there are 2 options: Basic Mode and Advanced Mode. We 

recommend checking the Advanced Mode option. This will reveal all parameters available for editing, 

which otherwise some will be hidden if Basic Mode is selected. 

 

 

 

http://www.daytona-twintec.com/
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Tables 

Tables are multi-row, column data, where two inputs X (columns) and Y (rows)give one output cell (table 

cell). These are often called 3D Maps.  

Tip: You can rotate the 3D chart display for a better view of a particular region by dragging the mouse 

while holding both mouse buttons down. Chart property pages and normalizers can be edited by right 

clicking on the chart. Almost any chart property can be changed. Click on the Help button for more 

information. If you corrupt the chart, exit and restart PC Link TCFI.  

 

Available tables are: 

1) Ignition Advance Table, with the option of Creating New Advance Table 

 

Use the Create New Advance Table command on the Edit…Tables > Create New Advance Table. A 

dialog box appears and allows you to enter initial timing and advance slope settings. Settings close to 5 

result in an advance table suitable for stock engines. Use lower values for high compression engines. Each 

time you click on Update, the corresponding advance table is displayed.  

 

 

You will find the Create New Advance Table command useful for 

generating an advance table that will serve as a starting point for further edits. 

When you are ready to proceed with editing, click on OK. After you have 

edited the table, you must use the Save Table Edits to Buffer command from 

the Edit menu to save your edits to buffer memory. If you use the Close Table 

command from the Edit menu, all your edits are lost.  

Once you have Ignition Advance Table data (by opening an existing data 

file, downloading data from a TCFI unit or creating a new table as explained 

previously), you can edit the data by clicking on and dragging individual 

points on the 3D chart display or you can directly edit numeric data on the spreadsheet grid.  

 

 

 

 

 

 

 

 

 

http://www.daytona-twintec.com/
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The table consists of 20 columns from zero to 7,500 RPM and 11 manifold pressure (MAP) rows from 10 

to 30 In-Hg. The 7,500 RPM 

advance value is used at all higher 

RPM levels and the 10 In-Hg MAP 

advance value is used at all lower 

MAP levels. Note that 10 In-Hg 

corresponds to a high vacuum 

deceleration or idle condition and 

that 30 In-Hg corresponds to wide 

open throttle (WOT).  Advance 

values must be between zero and 

45 degrees. You can shift the entire 

advance table up or down by 

holding the Shift key down while 

dragging any point. The chart label 

box shows the shift in degrees. 

When you release the mouse 

button, the chart and spreadsheet grid values will be updated. Response of the chart label box may be 

sluggish on slower systems due to the amount of data being updated.  

After you have edited the table, you must use the Save Table Edits To Buffer command from the Edit 

menu to save your edits to buffer memory. If you use the Close Table command from the Edit menu, all 

your edits are lost.   

 

Editing Tables Data – Same procedure for all 3D tables and Functions 

 

You can edit table data using standard Windows copy and paste operations by selecting cells and then 

clicking the right mouse button to pop-up the 

edit menu. You can select cells by dragging 

the mouse with left button down. You can 

also use the Modify command on the pop-up 

menu. When you enter a value, the presence 

of optional sign (+ or -) or percent (%) 

characters affects the outcome of the Modify 

command as shown in fig below.   

You can also use the Modify command on 

the pop-up menu. When you enter a value, 

the presence of optional sign (+ or -) or 

percent (%) characters affects the outcome of the Modify command.  

Data Export and Import 

You might want to export or import 3D table data to or from another application such as Microsoft Excel. 

Arrange the program windows so that both the source and destination are visible (one on the left side of 

the screen and the other on the right side seems to work best). You must be able to see the information 

http://www.daytona-twintec.com/
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you want to drag as well as the location where you want to drop it. To export from PC Link TCFI to 

Excel, use the left mouse button to select a range of data on the spreadsheet grid. Then move the mouse 

cursor to an edge around the selection. Hold the left mouse button down and drag the selection into Excel. 

Release the left mouse button on the top left cell in Excel. When importing into PC Link TCFI from 

Excel, use the same procedure, except that Excel requires dragging and dropping with the right mouse 

button.  

2) Main Fuel Table (also named Alpha-N Table) 

 

The Alpha-N table is the main fuel table (Alpha-N is the technical term for throttle position and RPM). 

The Alpha-N table values are in 

percent units. The calculated base 

injector pulse width (determined by 

horsepower and injector size 

settings on the module parameters 

screen) is multiplied by the Alpha-N 

table value to determine the 

theoretical injector pulse width for a 

14.7 air fuel ratio. This value is then 

corrected for the desired air/fuel 

ratio (as set on the AFR table) and 

BLM (block learn multiplier) to 

arrive at the actual rear injector 

pulse width. A feedback correction 

is applied based on the oxygen 

sensor signal and the stored closed loop correction values in the block learn multiplier (BLM) table. AFR 

reported by the WEGO is compared to the desired set point value in the AFR 3D table. 

From a practical standpoint, the Alpha-N table must be within about 20% of the required values for the 

TCFI system to successfully correct the injector pulse width based on closed loop feedback from an 

exhaust gas oxygen sensor.   

3) Front Cylinder Trim 

Table 

 

The front cylinder trim table 

values are in percent units. The 

calculated injector pulse width is 

multiplied by the front cylinder 

trim value to arrive at the front 

injector pulse width. Required 

front cylinder trim values are 

dependent on engine gas flow 

dynamics. 

 The front cylinder trim table is 

automatically corrected when the 

Apply Front BLM Table 

http://www.daytona-twintec.com/
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command is executed. If you exceed the horsepower limits listed in table Recommended Horsepower 

Limits, front cylinder trim may fail. 

 

 

Recommended Horsepower Limits 

 

   

 

 

 

4) AFR Command Table – Closed Loop (CL) 

 

The AFR (air/fuel ratio) table sets the 

desired air/fuel ratio under various 

operating conditions. The air/fuel ratio 

value is used in the rear injector pulse width 

calculation as explained above. Typical 

air/fuel ratios are 13.0 for idle, 13.8 for 

cruise, and 12.8 for wide open throttle. To 

prevent engine overheating, avoid lean 

air/fuel ratios exceeding 14.5 under cruise 

conditions. 

 

 

 

5) Front/Rear BLM Correction 

Tables (CL) 

The front BLM (block learn multiplier) 

table is shown in the graphic above. BLM 

values are in percent units and represent a 

correction factor required to maintain the 

air/fuel ratio set on the AFR table. BLM 

values are updated based on closed loop 

feedback from the exhaust gas oxygen 

sensors.  

 

 

 

Injector Size Horsepower Limit 

4.34 gm/sec (stock)  100 HP 

4.89 gm/sec (Screamin 
Eagle®  P/N 27654-06) 

110 HP 

http://www.daytona-twintec.com/
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6) Maximum BLM fuel Adjustment Table (CL) 

The values are in percentages. They represent the maximum allowed BLM learning in a given cell. AFR-

BLM are limited to the values dialed in 

the table. Corrections can be made both 

ways + or – (lean or enrich). 

Some special considerations apply to the 

BLM tables. BLM values are limited in 

range from 75% to 125%. The range 

limits are set on the module parameters 

screen. When a BLM cell nears the 

range limit, the cell color changes to red 

to alert the user that the system has just 

about run out of correction range and 

that the corresponding cell in the Alpha-

N fuel table must be changed.   

BLM cell values 0 and 1 command 

special functions and these cells are 

highlighted in blue. Closed loop 

feedback is disabled in any BLM cells 

with value 0. This is useful in operating areas where exhaust reversion effects may cause incorrect sensor 

readings. Note that most BLM tables will have the value 0 in cells corresponding to decel (RPM above 

idle and closed throttle) where reversion effects are most pronounced.  

BLM update, but not closed loop feedback, is disabled in any BLM cells with value 1. Some BLM tables 

may have the value 1 in cells corresponding to idle (1,000-1,250 RPM and closed throttle). 

 

After several hours of engine operation, read the ECU and examine the BLM tables. If you see red cells 

on a BLM table, you can use the corresponding (Front or Rear) Apply BLM Table command (on the 

submenu) to automatically correct the Main Fuel Table and Front Cylinder Trim Table (CL). You can 

choose to apply either front, rear, or both learnt values – Apply Front/Rear BLM Corrections – 

Recommended (CL). After running the Apply BLM Table command, the BLM table cells will return to 

100% and the learning process will start again. 

 

7) The Reset BLM Correction Tables (CL) command on the BLM Table submenu resets all BLM 

cells to 100%. 

 

FUNCTIONS 

Functions are two column tabular data, 2D maps. An input value (top row) gives an output value (bottom 

row). There are fourteen (in this version PC Link 20.4) 2D tables that you can edit. Before you can edit 

one of these tables you must either open a data file or download data from a TCFI unit. Each table 

consists of 17 columns with the upper row corresponding to the independent variable (throttle position, 

engine temperature, elapsed time, or IAC position. You can edit the numeric data corresponding to the  

http://www.daytona-twintec.com/
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dependent variable on the lower row of the spreadsheet grid. A typical 2D table is shown below. Some of 

the engine temperature cells are highlighted in red. These red cells correspond to invalid sensor readings. 

After you have edited the table, you must use the Close and Save Table to Buffer command from the 

Edit menu to save your edits to buffer memory. 

There is a Complete Function List under Edit…Functions section, which at the time of writing cannot 

be edited. You can skip it.  

Function table example 

 

 

Accel/Decel - Fuel Multiplier 

This table consists of a fuel multiplier (percent units) that is a function of delta throttle position. Delta 

throttle position means change in throttle position. Fuel multipliers greater than 100% for positive delta 

throttle position correspond to an acceleration enrichment which has a similar effect to an accelerator 

pump on a carburetor. Fuel multipliers less than 100% for a negative delta throttle position correspond to 

a deceleration enleanment (useful for reducing exhaust back fire).  

 

 

ET Based - Priming Fuel 

 

 
This table consists of an injector pulse width that is a function of engine temperature. The priming pulse 

occurs once on the initial ignition switch on event. Some of the engine temperature cells are highlighted in 

red. These red cells correspond to invalid sensor readings.  

 

ET Based Cranking Fuel 

 

 
This table consists of an injector pulse width that is a function of engine temperature. The cranking pulse 

width is used during engine start. Some of the engine temperature cells are highlighted in red. These red 

cells correspond to invalid sensor readings.  

 

 

 

 

http://www.daytona-twintec.com/
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Time Based Cold Start Enrichment Multiplier 

 

 
 

This table consists of a fuel cold start multiplier (percent units) that is a function of elapsed time since 

engine start. The overall fuel cold start enrichment is determined as follows: calculated injector pulse 

width for each cylinder is multiplied by the time-based fuel cold start enrichment and by the appropriate 

ET based front or rear cylinder cold start enrichment. The overall fuel cold start enrichment is then added 

to the injector pulse width. For example, assume that the calculated injector pulse width is 4 msec and that 

the time and ET based fuel cold start enrichment values are 50% and 25% respectively. The total injector 

pulse width is then 4.5 msec (0.5 x 0.25 x 4.0 + 4.0). The time-based fuel cold start enrichment should 

always taper off from 100% at zero elapsed time and must reach 0% at the maximum value of elapsed 

time (251 seconds). 

 

ET Based AFR Cold Start Enrichment Table 

 

 
 

This table consists of an AFR cold start multiplier (percent units) that is a function of engine temperature. 

This table does double duty for hot soak enrichment. Some of the engine temperature cells are highlighted 

in red. These red cells correspond to invalid sensor readings. In general, the values in this table will be 

correct for most applications and should not be changed without consulting tech support. 

 

Time Based – Individual Cylinder Cold Start Enrichment 

 

 
This table consists of a fuel cold start multiplier (percent units) that is a function of elapsed time since 

engine start. The overall fuel cold start enrichment is determined as follows: calculated injector pulse 

width for each cylinder is multiplied by the time-based fuel cold start enrichment and by the appropriate 

ET based front or rear cylinder cold start enrichment. The overall fuel cold start enrichment is then added 

to the injector pulse width. For example, assume that the calculated injector pulse width is 4 msec and that 

the time and ET based fuel cold start enrichment values are 50% and 25% respectively. The total injector 

pulse width is then 4.5 msec (0.5 x 0.25 x 4.0 + 4.0). The time-based fuel cold start enrichment should 

always taper off from 100% at zero elapsed time and must reach 0% at the maximum value of elapsed 

time (251 seconds). 

 

ET Based Front and Rear Cylinder Cold Start Enrichment Table 
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These tables consist of a fuel cold start fuel multiplier (percent units) that is a function of engine 

temperature. Individual tables are used because most engines exhibit significant differences in the 

characteristics of the front and rear cylinders. These tables also do double duty for hot soak enrichment. 

Note that a significant enrichment is required at high temperatures due to reduced injector flow. Some of 

the engine temperature cells are highlighted in red. These red cells correspond to invalid sensor readings.  

You may need to edit these two tables for optimum cold start and restart after hot soak. Please refer to 

the TCFI Idle Tuning Tech Note. for more information on this subject. 

 

Global Fuel Enrichment vs IAT Multiplier 

 

This table will add or remove fuel based in air intake temperature. Values above 100% add fuel, values 

below 100% subtract fuel. The table output is applied on top of other corrections. The valid range is 85 – 

125. 

 

Global Fuel Enrichment vs Baro 

 

This table adds or remove fuel based on barometric pressure. Values above 100% add fuel, values below 

100% subtract fuel. The table output is applied on top of other corrections. The valid range is 85 – 125. It works as 
intended, with one adverse effect on datalog screen.  

Note: do not modify it unless you have good reason. 

 

Fuel Injector Compensation vs Battery Voltage   

 

This table will add to the final calculated PW as the system voltage drops following charging system 

fault. Units are in microsecond, not millisecond (400µsec = 0.4 msec)   

 

ET Based Idle RPM Table  

 

This table consists of desired idle RPM as a function of engine temperature. The ET based IAC position 

(see table description below) is adjusted to maintain the desired idle RPM. Some of the engine 

temperature cells are highlighted in red. These red cells correspond to invalid sensor readings. 
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ET Based IAC Table 

 
This table consists of IAC (idle air control) value as a function of engine temperature. The IAC value is 

the minimum throttle position during idle in 0.1% units (i.e. an IAC value of 50 corresponds to 5% 

throttle). Greater IAC values result in more idle air and higher idle speed. IAC is continuously reduced as 

the engine warms up, even if the engine is not idling. Some of the engine temperature cells are highlighted 

in red. These red cells correspond to invalid sensor readings.   

 

ET Based IAC Start Adder Table 

 

 
This table consists of IAC (idle air control) value as a function of engine temperature. The values 

represent additional air flow through the idle system during engine starting. Generally, more air is 

required for a hot start, especially after a hot soak. Some of the engine temperature cells are highlighted in 

red. These red cells correspond to invalid sensor readings. 

Note: the bikes running TCFI7 and M8FI do not have an IAC per se; it is a virtual software device – it 

opens/closes the throttle blade in real time to adjust the airflow at idle based on the changing environment.     

 

 

THE TCFI LOG APPLICATION 
Overview, real time data view and logging  

 

 

After TCFI Log is launched, the main screen appears blank. You have multiple display options.  
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You can display real time engine data on an instrument panel type screen by using the View Real Time 

Data command on the View menu. You can display and print data logged by the TCFI unit on a chart 

recorder type screen. Data logged by the TCFI unit must be downloaded before it can be displayed, by 

using the Download Logged Data from TCFI command on the Communications menu. Once data has 

been downloaded, it is automatically displayed on a chart recorder type screen. You can save this data by 

using the Save File command from the File menu. You can display a previously saved data file by first 

using the Open File command on the File menu and then using the View Chart command on the View 

menu. 

You can also download, view, and print engine operating statistics and historical diagnostic codes by 

using the Download Statistics and Diagnostic Codes command from the Communications menu. Please 

note that this data is not saved.   

The USB interface, P/N 102004, is used for communication with the TCFI module. No additional 

hardware is required. The USB interface connects to the four terminal Deutsch data link connector that is 

part of the WEGO harness (refer to Figure 26 for details). The USB Interface has a switch that selects the 

operating mode. For communication with the TCFI, you must use the TC88A And All Others switch 

position.  

 

 
Turn the ignition key and engine run/stop switches ON to provide power to the TCFI unit. Do not 

start the engine. 

The TCFI Log program has auto-connect capability and a COM port scan 

function to aid in initial setup of the communications link. You can use the 

Port Setup command from the Communications menu to display the dialog 

box shown below and select the correct COM port.  

If you are not sure what COM port the USB interface has been assigned to, 

you can click on the Scan button to automatically detect and select the correct 

port. Before you do so, make sure that the USB interface has been connected to your PC and the TCFI 

module. Both the ignition key and engine run/stop switches must be turned on. Once the correct COM 

port has been selected, the program will remember this setting.   

If you enable the Auto Connect check box, the program will try to connect to the TCFI every time the 

program is started. Please note that you must have the correct COM port selected and the USB interface 

connected to your PC and the TCFI module. Both the ignition key and engine run/stop switches must be 

turned on in order for auto-connect to work properly. 
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Units Selections and Configuration File 

Use the Units Selection command on the Edit menu. A dialog box will appear as shown below. You can 

select miles per hour (MPH) or kilometers per hour (KPH) vehicle speed units, Fahrenheit (F) or Celsius 

(C) temperature units, inches of mercury (In-Hg) or kilopascals (kPa) manifold pressure units, pulse width 

in milliseconds or duty cycle in percent for injector data, and air/fuel ratio in gasoline AFR or Lambda 

units. The program remembers the selections you have made.

 

 

 

 

The most important item to setup/verify is the MAP Sensor configuration 1/2/3 bar. 

To verify: Open the Live Data View and look for the MAP value on the gauge. Confirm that the 

display matches the maximum range of your MAP sensor. Map sensor ranges are: 1 Bar in-HG 

10-30, 1 Bar kPA = 105, 

2 bar kPA = 220, 3bar 

kPA = 330.  To modify, 

edit the TCFI Log 

Software configuration 

file.  You can easily 

access and edit this file 

using under the menu 

File→Edit TCFI Log 

Software configuration 

file. To modify the TCFI 

Log Configuration file – 

it will automatically 

open in Notepad. Scroll 

down towards the end of 

the file and remove the 

semi-colon in front of 

the sensor type that you 

wis to log – in this example: “MAP2BAR_TRUE. Verify that a semi-colon is the first item on the 

other map sensor lines. Save the file, close and re-open the TCFI Log program to apply the 

changes. 
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LIVE DATA VIEW -- REAL TIME ENGINE DATA DISPLAY 
 

When the engine is running, you can display real time engine data on an instrument panel type screen by 

using the View Real Time Data command on the View menu. Please note that real time engine data 

cannot be directly saved by means of the TCFI Log program. However, this data is constantly being 

logged by the TCFI unit and can be downloaded (for example at the end of series of dyno runs). 

 

 

 

Real time engine data is displayed on an instrument panel type layout with round tach and speedometer 

gauges and bar graph type gauges for most other parameters. Barometric pressure, any diagnostic codes, 

status of the user input and output, and status messages are displayed in additional windows. If the engine 

is not running most values will appear as zero. 

Displayed parameters include: 

RPM – engine crankshaft RPM (numeric value displayed beneath gauge) 

VSS – vehicle speed in MPH or KPH (numeric value displayed beneath gauge) 
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TPS – throttle position (0 to 100%) 

TGS – twist grip position (0 to 100%) 

MAP – manifold pressure in In-Hg (29.92 In-Hg   or 101.3 kPa corresponds to atmospheric 

pressure) 

ECT – engine coolant temperature (On TwinCooled™ models only). Coolant pump and cooling 

fans status also displayed. 

ET – engine cylinder head temperature 

IAT – intake air temperature 

BAT – battery voltage 

IAC – idle air control value in 0.1% throttle position units (higher number means more idle air) 

AFR – the air/fuel ratio bar graph has dual pointers. The yellow pointer on the left side is the 

air/fuel ratio command (from AFR table). The white pointer on the right side is the actual air/fuel 

ratio based on the exhaust gas oxygen sensor reading. Note that the value will remain near 10 until 

the sensor has warmed up. Front and rear cylinder AFR values are displayed for all TCFI Gen 7 

units when the WEGO IIID is installed.  

BLM – block learn multiplier (main fuel table correction factor based on exhaust gas oxygen sensor 

feedback, shown as percent value from 75-125%). Separate front and rear cylinder BLM values are 

displayed. 

FRONT INJ, REAR INJ – injector pulse width in milliseconds or duty cycle in percent 

FRONT ADV, REAR ADV – ignition advance in degrees BTDC 

You can also select the vehicle speed, temperature, pressure, and injector data units used for real 

time engine data display and data logging chart display. Use the Units Selection command on the 

Edit menu. A dialog box will appear as shown below. You can select miles per hour (MPH) or 

kilometers per hour (KPH) vehicle speed units, Fahrenheit (F) or Celsius (C) temperature units, 

inches of mercury (In-Hg) or kilopascals (kPa) manifold pressure units, pulse width in milliseconds 

or duty cycle in percent for injector data, and air/fuel ratio in gasoline AFR or Lambda units. The 

program remembers the selections you have made. 

 

SPECIAL FEATURES  

 

ETC TEST MODE 

The ETC Test Mode command on the Communications menu has two options that allow you to test the 

electronic throttle control system without the engine running: 

Manual test. Throttle control actuator (TCA) throttle position follows twist grip sensor (TGS) command. 

This option is useful for a quick check of TCA operation. Enter “1” to enable ETC manual test mode or 

“0” to disable. Then select View Real Time Data on the View menu to view TGS and TPS data. 
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Characteristic curve. The system plots out the characteristic curve of TCA throttle position versus TCA 

motor pulse-width modulated (PWM) drive. This option allows detection of defects such as excessive 

friction, incorrect or noisy TPS signals, and broken gear teeth. Refer to Appendix A for more details. 

  

USER OUTPUT MANUAL OVERRIDE 
 

The User Output Manual Override command on the Communications menu allows you to manually 

override the user output on TCFI units. This command can be used as a diagnostic aid to test accessory 

systems connected to the user output. 

 

DATA LOGGING CHART DISPLAY 
 

You can also display data logged by the TCFI unit on a chart recorder type screen. The data logging 

memory within the TCFI stores the last 36000 data points at 10 samples/second. This corresponds to 60 

minutes of data. When you use the Download Logged Data from TCFI command on the Communications 

menu, the popup menu shown in Figure 19 will appear. You can select the length of the data set that will 

be downloaded. Once data has been downloaded, it is automatically displayed. The last data logged will 

appear at the right end of the chart. You can save the data by using the Save File command from the 

File menu after closing the chart display (data is not lost by closing the chart display). You can display a 

previously saved data file by first using the Open File command on the File menu and then using the 

View Chart command on the View menu. 

 

Download Options 

 

Please note that real time engine data cannot be directly saved by means of the TCFI Log program. 

However, this data is constantly being logged by TCFI unit and can be downloaded (for example at the 

end of series of dyno runs).  

Note that TCFI data files use a .log extension. You should create a separate folder to store these files.   
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 You can select two parameters for display. Trace 1 is displayed in red with its Y axis legends on the left 

side of the chart. Trace 2 is displayed in green with its Y axis legends on the right side of the chart. The X 

axis is always elapsed time. You can zoom in, zoom out, or zoom all (displays entire data file). At the 

maximum zoom in level, approximately 100 data samples will be displayed on the chart. You can use the 

scroll bar to move the chart display window in terms of elapsed time. If you hold the left mouse button 

down within the chart area, a cursor line appears. The exact values of the parameters displayed on trace 1 

and trace 2 and the elapsed time appear in windows above the chart. When you zoom in or zoom out, the 

displayed data will always be centered about the cursor line. This allows you to quickly select and closely 

examine an area of interest. If you want to analyze the elapsed time between two events (for example the 

time required to accelerate from 0 to 60 MPH), you can move the cursor to the first event and then click 

on the Reset Time Display button. You can print the displayed chart to any Windows printer by clicking 

on the Print button.  

 

Data parameters include: 

RPM – engine crankshaft RPM 

VSS – vehicle speed in MPH or KPH 

MAP – manifold pressure in In-Hg (29.92 In-Hg or 101.3 kPa corresponds to atmospheric pressure) 

TPS – throttle position (0 to 100%) 

TGS – twist grip position (0 to 100%) 
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AFR CMD – air/fuel ratio command (10:1 to 20:1). This is the AFR value the TCFI is attempting 

to maintain. 

FRONT AFR, REAR AFR – air/fuel ratio based on the exhaust gas oxygen sensor reading (10:1 to 

20:1). Front and rear cylinder AFR values are displayed for all TCFI Gen 7 units when the WEGO 

IIID is installed.  

FRONT BLM, REAR BLM – block learn multiplier (main fuel table correction factor based on 

exhaust gas oxygen sensor feedback, shown as percent value from 75-125%). Separate front and 

rear cylinder BLM values are displayed. 

IAC – idle air control value in 0.1% throttle position units (higher number means more idle air) 

IAT – intake air temperature 

ET – engine cylinder head temperature 

COOLANT TEMP – engine coolant temperature (on TwinCooled models only) 

COOLING PUMP – On/Off pump operation (on TwinCooled models only) 

COOLING FANS – On/Off fan operation (on TwinCooled models ony) 

FRONT INJ, REAR INJ – injector pulse width in milliseconds or duty cycle in percent 

FRONT ADV, REAR ADV – ignition advance in degrees BTDC 

BAT – battery voltage 

USER IN – user input displayed as digital (on/off) signal. On means that the input is active 

(grounded).   

USER OUT – user output displayed as digital (on/off) signal. On means that the output is 

grounded. 

CLUTCH – On means that the clutch is pulled in 

BRAKE – On means that a brake has been applied 

NEUTRAL – On means that neutral light is illuminated (transmission in neutral) 

TGS ROLLOFF – On means the twist grip is in the roll-off position 

CRUISE ENABLE – On mean the cruise switch is on. 

CRUISE ENGAGED – On means the cruise control system is controlling vehicle speed 

CRUISE SET – On means the cruise set button is pressed 

CRUISE RESUME – On means the cruise resume button is pressed 

ETC PWM – ETC system pulse width modulation command to the TCA motor (±100% range with 

negative values below limp back and positive values above)  

 

http://www.daytona-twintec.com/


   

 
Daytona Twin Tec 240 Springview Commerce Dr  BLD 1-J Debary, FL 32713  TCFI7 M8FI Tuning Manual Rev 3.0  
(386) 304-0700   www.daytona-twintec.com  5/2024 

Page 25 

 

Additional data is displayed at the lower right side of the screen. This data includes: 

Diagnostic Code – normally blank unless a diagnostic code is set. Refer to page 12 for details. 

Engine Status – based on engine temperature and open/closed loop AFR  

Log Interval – the actual data logging interval in seconds 

You can clear the data within the TCFI by using the Clear TCFI Data Buffer command from the 

Communications menu.  

The following additional functions are available from the Edit menu: 

Fuel Cell Display – shows the active cell in terms of RPM and TPS percent at the cursor position. 

TPS percent is compensated for idle air. This function is useful for determining what fuel table cell 

is active at any given point in time. The same RPM and TPS cell is active in all fuel tables. 

Gear Ratio Display – shows the calculated gear ratio (RPM/KPH) at the cursor position. This 

function is useful for determining the 6th gear ratio required for Module Parameter setup in PC Link 

TCFI for the 6th gear indicator light.  

Misc Data Display – shows the current barometric pressure and nominal IAC value (value learned 

by system when engine is completely warmed up and at stable idle condition). 

 

IMPORTING DATA INTO EXCEL 

Data files saved from TCFI Log are in comma delimited ASCII format. You can easily import a data file 

into other programs such as Microsoft Excel for further analysis. You can also view data files with a text 

editor such as Windows WordPad. To import a data file into Excel: 

1. Start Excel. In the File Open dialog box, select Files of type: All Files (*.*). Then browse for the data 

file. 

2. The Text Import Wizard appears. For step 1, select delimited file type. For step 2, select comma 

delimiter. For step 3, select general column data format. Then click on Finish. 

3. You can then format the data and save the spreadsheet as an Excel file. 

 

OPERATING STATISTICS 

You can also display and download engine operating statistics logged by the TCFI unit. Data logged by 

the TCFI unit must be downloaded before it can be displayed, by using the Download and View 

Statistics/Diagnostic Codes/ Diagnostic Codes command on the View and Download Logged ECU 

Data menu. Once data has been downloaded, it will automatically be displayed. Please note that this data 

is not saved.   

The data is fairly self-explanatory. Total hours represents the total time that the engine was running. ID 

represents the firmware identification. This field typically includes the manufacturer (Twin Tec), model 

number, program revision and author's initials, and date. Note that the date is not a manufacturing date 

code, just the date for the particular firmware release.  
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Elapsed time is displayed for 13 RPM bands from idle to 6999 RPM. Note that elapsed time data is 

rounded off during each engine run, so the sum of the elapsed time figures may not precisely match the 

total hours. The program also displays the maximum engine RPM, time at the RPM limit (in seconds for 

better resolution) and the number of engine starts.  

Clicking on the Print Statistics button prints a report. When you click on this button, a small data entry 

screen pops up and allows you to add a serial number or comment that will appear on the printout. You 

can also use the Print command from the File menu.  

 

 

 

Any historical diagnostic codes logged by the TCFI unit are listed along with the number of trips (engine 

start cycles) since the individual code was last logged. Codes are automatically cleared after 50 trips.   

Customers are often confused about the meaning of the term “trips.” This is an industry standard 

terminology. If a code shows 40 trips, it means that the code was set 40 engine start cycles ago, not 

that the code has been set 40 times.  

You can clear historical diagnostic codes by using the Clear Historical Diagnostic Codes command from 

the Special Features menu. 

The elapsed time data in the various RPM bands can be displayed in the form of a histogram chart by 

clicking on the Histogram button. Color coding of the bars helps to interpret the data. The idle RPM band 
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is blue, normal operating RPM bands are green and high RPM bands are yellow and red. The chart is 

automatically scaled for best display. You can print the chart along with a complete statistics report by 

clicking on the Print Chart button. 

 

BASIC TUNING RECOMMENDATIONS AND PROCEDURES 

ENGINE STARTING PROCEDURE   

 

With alpha-N fuel control, the proper engine starting procedure must be followed. When the 

run/stop switch is turned on, the ETC system runs an auto-calibration routine that establishes the zero 

(closed throttle) position. During this time, the check engine light is on and the fuel pump is energized for 

several seconds, making an audible buzz. Do not press the starter button until the check engine light goes 

out and the fuel pump stops buzzing.  

We recommend that you let the engine idle for about 20-30 seconds before operating the motorcycle. This 

allows the closed loop idle air control system to stabilize idle RPM.  

 

IDLE TUNING 

Please note that during the initial period after engine start, fuel control is open loop (no feedback from the 

WEGO sensors) and relies entirely on correct values in the Alpha-N table. The TCFI will enter closed 

loop AFR control mode after the WEGO warm up time (nominal value of 30 seconds) has elapsed.   

To allow viewing and logging AFR data immediately after engine start, turn the ignition switch on but 

leave the run/stop switch in the stop position. Wait at least 15 seconds for the WEGO sensors to warm up 

and then start the engine. Monitor engine data and status with TCFI Log software. 

Allow the engine to idle until it reaches normal operating temperature of 110° C or 230° F. A fan should 

be used to direct cooling air on the engine to more realistically simulate actual warm up conditions and 

prevent the engine from overheating. If the engine does not start or stalls, please refer to the diagnostic 

tips at the end of this section.  

Monitor front and rear cylinder AFR and BLM, engine temperature, and IAC values. Keep notes on your 

observations of these values. After 30 seconds, the system should be operating in closed loop and 

maintaining the desired idle AFR (nominal value of 13.5). The BLM values should remain within the 

range of 80-120%. The IAC value should slowly go down as the engine reaches operating temperature 

and requires less idle air.    

BLM values below 100% indicate that the TCFI is removing fuel in closed loop to correct a rich 

condition. BLM values above 100% indicate that the TCFI is adding fuel in closed loop to correct a lean 

condition.  

If the BLM values go below 80% or above 120% anytime during the warm up period, the system is 

running out of adjustment range and the idle cells in the Alpha-N fuel table should be edited before 

proceeding with further tuning. 

Download the current setup with PC Link TCFI software and use the Edit 3D Table – Alpha-N Table 

command to edit the idle cells in the Alpha-N fuel table. Depending on engine temperature, IAC value 

and idle RPM, the TCFI will be using the cells in the 750, 1,000, 1,250, and 1,500 RPM columns and the 
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0%, 2.5% (IAC between 15-40), and 5% TPS (IAC above 40) rows. You can select all these cells, right 

click the mouse, and then use the Modify command on the pop-up menu. Add a percentage corresponding 

to the BLM error. For example, if the worst-case BLM value noted was 120%, add 20% fuel by entering 

+20% (not +20). Likewise, if the worst-case BLM value was 80%, subtract 20% fuel by entering -20%. 

Remember to use the Save Table Edits to Buffer command after editing the table. Then use the Edit 3D 

Table – BLM Tables – Reset BLM Tables command to reset all BLM values to 100%. Save the edited 

setup file to disk and upload it to the TCFI. 

As mentioned above, the IAC value should slowly go down as the engine reaches operating temperature. 

The IAC value should drop to near the nominal value (15-30 as set under basic module parameters). If the 

IAC value stays above 40 or drops below 15, there may be an electromechanical problem with the TCA or 

a manifold vacuum leak (very low IAC).  

After making any required edits repeat the start test and allow the engine to reach normal operating 

temperature. Make sure the engine runs for at least 5 minutes and the status display shows warm 

closed loop operation – otherwise BLM values will not be saved.  

The idle tuning step is complete when BLM values stay within the range of 85-115% during the warm up 

phase and the IAC value is within the range of 15-30 once the engine reaches normal operating 

temperature. If these criteria cannot be met, please contact our tech support before proceeding. 

Diagnostic tips if the engine does not start: 

1. Verify that the TCFI is properly installed and set up, that the battery is fully charged, and that the 

engine is not flooded from excessive priming caused by repeatedly cycling the run/stop switch during 

setup. Disconnect the fuel pump relay and crank the engine to clear flooding.  

2. Try the following starting procedure: set the run/stop switch to run, wait until the fuel pump stops 

running, slightly open the throttle, and then press the starter switch. If the engine starts, the problem 

may be insufficient air caused by an incorrect IAC value. Please contact our tech support before 

proceeding.  

3. Ether starting spray can be used as a diagnostic aid. Try starting the engine after an application of 

ether spray. If the engine starts and runs at a normal idle RPM, the problem is insufficient fuel. Try 

increasing the priming and cranking fuel values by 10-20%. Download the current setup with PC Link 

TCFI software and use the Edit 2D Table – ET Based Priming Fuel Table and ET Based Cranking 

Fuel Table commands. Select all cells, right click the mouse, use the Modify command on the pop-up 

menu, and enter +10% (not +10). Remember to use the Save Table Edits to Buffer command after 

editing each table. Save the edited setup file to disk and upload it to the TCFI. Retest and repeat if 

additional fuel seems to be required.  

4. If larger fuel injectors were installed, cranking and priming fuel values may need to be decreased. Try 

decreasing the priming and cranking fuel values by 20%. Download the current setup with PC Link 

TCFI software and use the Edit 2D Table – ET Based Priming Fuel Table and ET Based Cranking 

Fuel Table commands. Select all cells, right click the mouse, use the Modify command on the pop-up 

menu, and enter -20% (not -20). Remember to use the Save Table Edits to Buffer command after 

editing each table. Save the edited setup file to disk and upload it to the TCFI. 

5. Try re-installing the stock ECM. If the engine does not start with the stock ECM, there may be an 

underlying problem that requires correction. If the engine starts with the stock ECM but not the TCFI, 

please contact our tech support for assistance.     
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6.  

Diagnostic tips if the engine stalls: 

1. If the engine momentarily starts, runs for several revolutions (less than 2 seconds), and then stalls, 

priming and cranking fuel values may be insufficient to build up the required fuel film in the intake 

manifold. Try using ether starting spray or cycling the run/stop switch several times to add additional 

priming fuel before starting the engine. If the engine starts normally, you have confirmed that more 

fuel is required. Try adding 10-20% more priming and cranking fuel as explained in Paragraph 2 in 

the preceding section.  

2. If the engine stalls after running for several seconds, observe AFR values. To do this you must allow 

the WEGO sensors to warm up for at least 15 seconds before starting the engine. You can observe 

data in real time or download data logged using TCFI Log. For best results, select the 10 samples/sec 

download option. In most cases, the problem is caused by excessively lean AFR. Based on observed 

AFR values, make appropriate corrections to the idle cells in Alpha-N table. If the AFR is lean, try 

adding 10-20% fuel (use the procedure explained on page 6). If this does not solve the problem, please 

contact our tech support for assistance. 

3. In some cases, changes to the cold start enrichment tables may be required. There are independent ET 

(engine temperature) based front and rear cylinder cold start enrichment tables. To allow viewing and 

logging AFR data immediately after engine start, turn the ignition switch on but leave the run/stop 

switch in the stop position. Wait at least 15 seconds for the WEGO sensors to warm up and then start 

the engine. Monitor engine data and status with TCFI Log. Download the logged data. Compare the 

front and rear AFR values after engine start to determine if adjustments are required. Refer to the 

TCFI Idle Tuning Tech Note for more details.      

4.    

AUTO-TUNING 

The closed loop auto-tuning process consists of operating the motorcycle through a wide range of loads 

and speeds while periodically monitoring progress using the PC Link TCFI software. Long rides at 

constant speed and load are of no value. The best technique is to very slowly accelerate through the 

useable RPM range in every gear, allowing several seconds of operation in each RPM and throttle 

position-based cell. Also operate the motorcycle at various fixed speeds likely to be encountered during 

normal riding. For safety reasons, wide open throttle runs should be done on a closed course.  

We recommend auto-tuning under actual riding conditions. If this is not possible, you can auto-tune on a 

load control dyno and use TCFI Log to monitor AFR and other engine parameters.  

If AFR values appear very lean (above 14.5), we suggest that you edit the Alpha-N table to add 15-20% 

fuel to all cells except idle cells before proceeding. Auto-tuning works best if you start with a slightly rich 

Alpha-N table. Download the current setup with PC Link TCFI software and use the Edit 3D Table – 

Alpha-N Table command. You can select groups of cells, right click the mouse, use the Modify command 

on the pop-up menu, and enter +15% (not 15). Remember to use the Save Table Edits to Buffer command 

after editing each table. Save the edited setup file to disk and upload it to the TCFI. 

After 1-2 hours of engine operation, download the current setup with PC Link TCFI software and use the 

Edit 3D Table – BLM Tables – Edit Front and Edit Rear BLM Table commands to examine the BLM 

tables. Cells that are shaded red indicate that the system has run out of correction range. Then use the  
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Apply Front and Apply Rear BLM Table commands to automatically correct the Alpha-N fuel table and 

front cylinder trim table. This also resets all the BLM values back to 100% and allows auto-tuning to 

continue. Save the edited setup file to disk and upload it to the TCFI.  

Auto-tuning is a statistical process. The longer the operating time, the greater the probability that more 

cells will be covered. However, even a varied operating cycle can miss some cells. After you use the 

Apply BLM Table commands, take some time to examine the modified Alpha-N and front cylinder trim 

tables. Unless your engine has some unusual camshaft and exhaust interactions, the tables should appear 

smooth (with gently rising slopes). If you spot sharp spikes or dips, these cells have probably been missed 

during auto-tuning and will require some manual edits to smooth them into the surrounding terrain.  

The Alpha-N table represents percent injector pulse width (fuel flow) before correction for BLM, front 

cylinder trim, barometric pressure, intake temperature, and cold start enrichment. You can use the 

following guidelines to smooth the Alpha-N table: 

1. At part throttle (low TPS%), Alpha-N values in each row will tend to decrease as RPM increases 

(because the throttle is choking air flow). 

2. At wide open throttle, Alpha-N values in each row will tend to follow the engine torque curve. 

3. In any given RPM column, Alpha-N values must always increase with TPS. 

The front cylinder trim table may appear more complex and irregular, with peaks and valleys 

corresponding to gas flow interactions within the intake and exhaust system. However, very sharp spikes 

and dips may require some smoothing. 

If you edit the Alpha-N or front cylinder trim table to smooth out values, remember to use the Save Table 

Edits to Buffer command after editing each table. Save the edited setup file to disk and upload it to the 

TCFI.          

Continue to operate the motorcycle under varying conditions for another 1-2 hours. Then repeat the 

process of downloading setup data, examining the BLM tables, using the Apply BLM Table commands, 

smoothing the Alpha-N and front cylinder trim tables, saving, and uploading back to the TCFI as 

previously described.   

Continue this auto-tuning process until most of the BLM cells remain in the 90-110% range.  

If spark knock is noted under wide open throttle or throttle roll-on, use PC Link TCFI software to edit the 

ignition advance table and reduce the ignition advance 3-5 degrees under the conditions that cause spark 

knock. Using the TCFI Log software to examine engine data may be very helpful for determining exactly 

what manifold pressure and RPM values were encountered. A common error is to assume spark knock 

only occurs at high MAP (manifold absolute pressure) values. Large displacement engines are prone to 

spark knock at relatively low MAP values during throttle roll-on. You may need to reduce the ignition 

advance throughout the entire MAP range. 

 

FUEL INJECTOR SIZING 

Accepted engineering practice is to use the smallest possible injectors (in terms of flow) for best control at 

idle and part throttle. The original equipment throttle body and similar aftermarket units with Siamese 

runners are subject to fuel imbalance problems between the front and rear cylinders. When the fuel  
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injector duty cycle exceeds 50%, fuel will start being inducted into the wrong cylinder (i.e. front injector 

spraying fuel while rear intake valve is still open). The TCFI system cannot correct this problem.  

Table 1 lists conservative horsepower limits based on injector size. You can use TCFI Log software to 

check the injector duty cycle at wide open throttle.  

 Recommended Horsepower Limits 

 

   

 

 

 

IDLE TUNING CONSIDERATIONS 

Some large displacement engines with high overlap/long duration camshafts may not idle properly at the 

nominal 1,000 RPM and 13.5 AFR settings used in the standard setup files. You may have to increase the 

idle RPM to a higher value such as 1,100 RPM and enrich the idle to 12.5-12.8 AFR.  

Download the current setup with PC Link TCFI software and use the Edit 2D Table – ET Based 

Idle RPM command to increase the idle RPM. Do not decrease values at the left of the table 

(corresponding to a cold start condition) that are already higher than your desired idle RPM. If you 

significantly increase idle RPM, you may also have to make corresponding edits to the ET Based IAC 

Position table. Then use the Edit 3D Table – AFR Table command and change the applicable idle cells 

(750 -1,500 RPM at 0-5% TPS) to the desired AFR value. Remember to use the Save Table Edits to 

Buffer command after editing each table. Save the edited setup file to disk and upload it to the TCFI.   

 

DYNO TUNING CONSIDERATIONS 

Auto-tuning using the procedures listed on page 7 will get you within a few horsepower of the 

maximum that the engine can deliver. If you decide to do dyno tuning for maximum power, you can 

experiment with wide open throttle (WOT) ignition timing and AFR. Please pay careful attention to the 

following dyno tuning considerations: 

1. Only edit the ignition advance and AFR tables. Don’t edit any other tables (never make any 

changes to the BLM or Alpha-N tables once auto-tuning is completed). The usual range for WOT 

ignition timing at 4,000-6,000 RPM is about 28-34 degrees BTDC. The usual range for WOT AFR is 

about 12.5-12.8. Some engines may require a richer mixture, possibly down to 11.5, to avoid 

detonation problems.       

2. The TCFI should be operated in closed loop. Make sure that the engine is warmed up (oil 

temperature is in the 150-180° F range) before doing a run and that engine status in TCFI Log shows 

closed loop operation. If you have made any table edits, allow one run for auto-tuning before 

capturing data. 

 

Injector Size Horsepower Limit 

4.34 gm/sec (stock)  100 HP 

4.89 gm/sec (Screamin 
Eagle®  P/N 27654-06) 

110 HP 
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3. Inadequate air flow for engine cooling is a major problem with many dyno systems. Always let 

the engine cool off between dyno runs. The use of a separate heavy duty industrial grade fan capable 

of generating at least 50+ MPH air velocity at the front of the engine is recommended. You can 

measure the air velocity with a handheld anemometer such as Extech P/N 45118 available from 

Grainger.  

4. Use the TCFI data logging capability. Always download data with TCFI Log software at the end of 

every run and study the results (use the 10 samples/sec download option). Check engine and air 

temperatures, throttle position, manifold pressure, and AFR. TCFI Log is a very powerful tool that can 

help you identify potential problems that may be affecting engine performance. Inconsistent dyno test 

results are often the result of thermal problems (engine temperature variations or hot soak effects).  

5. Dyno exhaust sniffer limitations. Some of the older sniffers monitored CO and CO2. These systems 

are so slow and inaccurate that they should be totally disregarded. Modern sniffers from Dynojet and 

Horiba use a wideband sensor similar to the WEGO sensor. These sniffers are still subject to 

erroneous lean readings caused by reversion of atmospheric oxygen if the probe cannot be inserted 

past the baffles in the exhaust. Sensor degradation caused by leaded racing gas is a common 

occurrence. Another problem is sampling delay due to the long hose between the sniffer tip and actual 

sensor. The bottom line is to trust your WEGO sensors and disregard any errant readings from an 

exhaust sniffer. 

 

ENGINE TUNING GUIDELINES 

Higher AFR values correspond to a leaner (less fuel) condition. The practical operating range for 

most engines using gasoline fuel is from approximately 11.5 to 14.7 AFR. Combustion of a stoichiometric 

mixture (exactly enough air to burn all the fuel) results in 14.7 AFR indication. Automotive engines with 

catalytic converters operate near 14.7 AFR during cruise and idle. Air-cooled motorcycle race engines 

usually require a richer mixture to limit cylinder head temperature and prevent detonation. Table 2 lists 

recommended AFR values for race engines without emission controls. 

Recommended AFR Values 

 

 

 

 

 

 

 

 

  

 

 

 

 

Operating Mode Recommended AFR 

Cold Start (first 30 sec) 11.5-12.5 

Idle 12.8-13.5 

Part Throttle Cruise  13.0-14.0 

Wide Open Throttle 12.5-12.8 (values down 
to 11.5 may be used to 
reduce detonation) 
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EXHAUST CONSIDERATIONS 
 

The use of a WEGO system for closed loop fuel control places constraints on the choice of exhaust 

system. The WEGO system may give inaccurate results in certain situations:    

Exhaust reversion. Reversion is the term for a negative pressure wave that can suck ambient air 

back into the exhaust and cause an erroneous lean AFR indication. Reversion effects will be most 

noticeable at idle, part throttle low RPM cruise, and decel. Open drag pipes suffer from reversion effects. 

Please note that if you use drag pipes or other open pipes, auto-tuning may not be possible at idle or part 

throttle due to reversion effects. In this case, you have three options: 

1. Modify the exhaust to allow auto-tuning at idle and part throttle by adding a restriction such as the 

washers shown in Figure 1 or some other type of baffling. For race applications, you can remove the 

restriction after auto-tuning the idle and part throttle cells and then lock out closed loop operation by 

using the special value 0 in the BLM tables for these cells. 

2. Use a rubber hose to extend the exhaust length during auto tuning at idle and part throttle. For more 

information, please contact our tech support. 

3. Manually tune the fuel tables for idle and part throttle cells. This involves trial and error and is not 

recommended. Closed loop operation in idle and part throttle cells must be locked out by using the 

special value 0 in the BLM tables for the affected cells.  

You can reduce reversion effects in open drag pipes and mufflers without restrictive baffles with the 

modification shown in Figure 1. Use washers with an OD that is 2/3 to 3/4 the ID of the pipe (for 

example, 1-1/2” OD washers are suitable for pipes with an ID of 2” to 2.25”). Weld ¼-20 socket head cap 

screws to the washers as shown. Drill holes at the bottom of the pipes about 2” from the end and use 

decorative acorn nuts to secure the washer assemblies. We suggest that you use stainless steel hardware.  

The washers will reflect positive pressure waves that will cancel out the negative pressure waves 

reflecting from the end of the pipes. You can turn the washers just like throttle blades to provide more or 

less restriction. Dyno tests will show a significant increase in midrange torque and a small drop in top end 

horsepower as the restriction is increased.   

 

HOT STARTING PROBLEMS 

Some engines are prone to hot starting problems. When cranked after a short hot soak, the engine may 

“kick back.”  Over time, this will cause damage to the ring gear and starter pinion.  

The TCFI module uses an improved starting algorithm that includes a programmable cranking delay. The 

TCFI module is shipped with a zero cranking delay: it fires on the first recognized compression stroke. 

This works best on stock and mildly modified engines.  

High compression engines will generally require compression releases. When compression releases are 

installed, best starting results will be obtained by programming the TCFI module for a 1-2 revolution 

cranking delay. This can be done by means of the PC Link TCFI software.   
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SPARK KNOCK PROBLEMS WITH HIGH COMPRESSION ENGINES 

Spark knock problems may be encountered with high compression engines. If engine parts were “mixed 

and matched” from different suppliers, the actual compression ratio may differ substantially from the 

expected value. You cannot estimate compression ratio with cranking compression tests, as camshaft 

timing usually causes an erroneous low reading. 

To accurately calculate compression ratio, you must measure the combustion chamber volume and use the 

formula: 

Compression = (Head cc + Deck cc + Cylinder Volume) 
Ratio                                  (Head cc + Deck cc) 

 

The practical limit for compression ratio is about 10.5:1 to 11:1 when running 93 octane pump gas. Any 

higher compression ratio will require retarding the ignition timing to the point where more power is lost 

from the retarded timing than is gained from the higher compression.  

If spark knock is encountered during operation, you can use the TCFI Log software to download data and 

examine the operating conditions (RPM and manifold pressure) where spark knock occurred. You can 

then make appropriate reductions to the ignition advance table. Large displacement, high compression 

engines are prone to spark knock at relatively low MAP values during throttle roll-on. You may need to 

reduce the ignition advance throughout the entire MAP range.  

 

ACR SYSTEM 

Engines on some models are equipped with an automatic compression release (ACR) system. The TCFI 

Gen 7 supports the ACR system. No modifications or other special considerations are required. The ACR 

output on pin 19 of the ECM connector is active during the cranking revolutions set under Module 

Parameters (refer to page 26) if this parameter is set to a non-zero value.  

 

SUPPORT FOR TWINCOOLED™ ENGINES 

2014+ engines that have factory liquid cooling systems can have full compatibility and adjustability 

with the use of version 1.80 firmware and PC Link 18.1 and TCFI Log 18.1. No hardware changes are 

necessary; however, you must have TCFI7 firmware version 1.80 to utilize the coolant pump and cooling 

fans (see TCFI Gen 7 Rev 1.80 Firmware Update Tech Note).  

The coolant pump will run when the engine is running, or when the conditions below exist: 

Fans are turned on based on coolant temperature and vehicle speed. These are the stock settings: 

Fan On Temp Below VSS : 105°C. This is the temperature setting that fans will turn from zero vehicle 

speed up to the programmed vehicle speed. 

Fan On Temp Above VSS: 118°C. This is the temperature setting at which the fans will remain on above 

the programmed vehicle speed. 

Speed for above Fan Settings 24 KPH. This is the vehicle speed breakpoint that the fan logic will follow 

to turn on the fans.  

Fan Off Hysteresis: 8°, any scale. This is a temperature hysteresis value so the cooling system doesn’t 

constantly turn itself on/off. 
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When the engine is switched off and the cooling system needs to continue running(ex: Turbo Timer), the 

following can be adjusted:  

Engine Off Fan Timer: 180 seconds 

Engine Off Cooldown Temp: 95°C  

Finally, the coolant temperature, coolant pump operation, and fans operation are logged in version 18.1+ 

of the TCFI Log software. 

 

USER FUNCTIONS 

The TCFI user input on pin 56 of the ECM connector can be connected for a stage RPM limit function as 

shown in Figure 2. The stage limit switch must be normally open. You can use a microswitch attached to 

the clutch lever. When the clutch lever is pulled in, the switch contacts should close to activate the stage 

RPM limit. Refer to the User Functions section on page 28 for details on programming the stage RPM 

limit. 

Figure 2 – Stage Limit Switch Wiring Diagram 

 
The TCFI user output on pin 20 of the ECM connector can drive a standard automotive relay connected as 

shown in Figure 3. When the user output is active, +12V power is applied to the load. Refer to the User 

Functions section on page 28 for details on programming the user output. 

Figure 3 – User Output Relay Wiring Diagram 

 
CUSTOM BIKE AND AFTERMARKET ACCESSORY CONSIDERATIONS 

Tight integration exists between the engine control module (ECM) and body control module (BCM) on 

Harley-Davidson® models with CAN data bus. It is not possible to run one of these models without a 

BCM.  
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The original equipment ECM has no connector terminal assignment for a tach signal. Engine RPM data is 

only available on the CAN data bus. Any aftermarket accessories that require engine RPM data will 

require an appropriate CAN data bus interface. 

 

TECH SUPPORT 

If you require tech support for tuning issues, we will ask you to email us both the current setup file 

(downloaded by means of PC Link TCFI) and a data logging file (downloaded by means of TCFI Log) 

that shows the problem. The data logging files are large and tend to be corrupted when attached to an 

email. You suggest that you use an archiving program such as PKZIP or WinZip to compress the 

files prior to attaching them to an email. You can send email to techsupport@daytona-twintec.com. 

Please make sure that you include your full name, phone number, complete information about the engine 

setup, and a detailed description of the problem. We suggest that you call us first to discuss the situation. 

 

ENGINE DIAGNOSTICS 

The TCFI Gen 7 version has extensive diagnostics. When the ignition switch is first turned on, the check 

engine LED illuminates. The LED goes out when the system initialization is complete.  

If a diagnostic fault is detected while the engine is running, the LED will illuminate. Diagnostic codes can 

be read and cleared by means of the speedometer (same as with the OE ECM) or TCFI Log software. 

Most of the diagnostic codes are the same as those used by H-D and the H-D Electrical Diagnostic 

Manual for your model should be employed as a primary troubleshooting reference. Certain diagnostic 

codes that are unique to the TCFI or require special consideration are listed below:   

P0373 CKP Signal Lost. This code will appear if the engine stalls. Customers are often confused 

about the meaning of the term “trips” associated with codes, especially P0373. This is an industry 

standard terminology. If code P0373 shows 40 trips, it means that the code was set 40 engine start 

cycles ago, not that the code has been set 40 times and that the crankshaft position sensor is 

defective. 

P0132 Rear Oxygen Sensor High, P0134 Rear Oxygen Sensor Low/Open, P0152 Front 

Oxygen Sensor High, or P0154 Front Oxygen Sensor Low/Open.  These codes indicate a 

problem with the WEGO IIID unit. P0134 and/or P0154 will be set if the WEGO signal connection 

(white and blue wires) or WEGO power is lost. These codes may also be set if a Bosch sensor fails 

or becomes contaminated by leaded gasoline. 

 

REINSTALLING THE ORIGINAL EQUIPMENT ECM   

Removal of the WEGO system is not required for simple operational tests such as verifying that the 

engine will start and run.  
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FAIL to START TROUBLESHOOTING FLOWCHART 

 Experience has shown that most units returned for warranty are OK and another problem, such as user 

error including improper setup or tuning, an intermittent wire harness connection, or defective coil, fuel 

injector, or sensor is later identified. 
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WEGO TROUBLESHOOTING FLOWCHART 

Follow the troubleshooting flowchart shown below. Experience has shown that most units returned for 

warranty are OK and another problem, such as user error, a degraded sensor, or bad power connections is 

later identified. 
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COMMUNICATIUONS TROUBLESHOOTING FLOWCHART 

Follow the troubleshooting flowchart shown below. Experience has shown that most communication 

problems are user error or PC compatibility issues. 
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